Overview

Write-N-Cite (WNC) is a utility that allows users (who meet the compatibility requirements below) to run an abbreviated version of RefWorks in Microsoft Word.

This version of RefWorks displays Author, Title, and Year Only, with a full view option available if needed. This version of WNC allows for faster processing of large documents as only the temporary citation placeholders (versus the entire document) are sent to RefWorks for formatting and returned to your original paper with the bibliography. This version of WNC no longer creates a FINAL manuscript. For that reason we strongly encourage you to make and/or work with copies of any important documents. This version also includes the ability to work on a paper and format a bibliography offline.

With Write-N-Cite, you can cite references in a manuscript with the click of a button. The abbreviated version can be set to Always on top so that it stays in place as you are typing your manuscript and generating your bibliography. The utility installs a Write-N-Cite button on your desktop as well as an Add-in to your Word toolbar and a menu option in Word, under Tools for launching Write-N-Cite.

Write-N-Cite System Requirements and Compatibility

Operating System

- Windows XP or later (including VISTA)
- 64 MB of RAM
- 1.5 MB of available hard-disk space
- Internet connectivity

Browser Requirement

- Internet Explorer 6 or higher

Compatibility

Write-N-Cite is compatible with Microsoft® Word 2003 or later.

Installing Write-N-Cite III

To install Write-N-Cite III for a single user for the first time:

Note: Do not install Write-N-Cite with Microsoft Word running.
1. Click on the file called WNCInstall that you have saved to your computer.

**Note:** If you have an older version of **Write-N-Cite** on your computer, you will be prompted to say “yes” to have that version uninstalled before the new version is installed.

2. Follow the instructions in the set-up wizard and designate a location to save **Write-N-Cite** (by default, RefWorks will create a new directory which you can use or change)

3. You will be given the option to install for “all users of this computer” or just a specific user. Select the appropriate option.

4. Select **Allow Working Offline** if you want to be able to take advantage of the offline capabilities (**Write-N-Cite for Windows III Only**).

5. By default, **Write-N-Cite** will install a toolbar in Word for easy launching of the software. Deselect this option if you do not want this toolbar.

**Note:** The toolbar only installs for a single user. If you are using a computer with multiple users, you must go to Programs/RefWorks and select **Install Write-N-Cite plug-in for Word** to add this toolbar.

5. Follow the remaining instructions to finish installation.

Once you have completed installation, **RefWorks** gives you three options accessible from Programs/RefWorks:

- Install **Write-N-Cite** plug-in for Word – allows multiple users of a single computer to add the **Write-N-Cite** icon to Word.

- **WNC Proxy Configuration Utility** – allows you to configure **Write-N-Cite** for off-campus use via a proxy server.

- **Write-N-Cite** – alternate way to start **Write-N-Cite**.

For installation on computers in a networked situation, please see:

https://www.refworks.com/RWSingle/help/Installing_Write-N_Cite_on_a_Network.htm

**Working in Write-N-Cite III**

Launch Write-N-Cite from within Word by clicking the toolbar button or by selecting Write-N-Cite from the Tools menu. You can also launch the program from the Write-N-Cite icon on your desktop or by clicking the Start menu and selecting RefWorks from All Programs..
When the login dialog box appears, enter your RefWorks user name and password and click Login.

Click the box next to Always on Top to keep Write-N-Cite on top/in front of all other programs including Word. Also, notice that the name of the Word document that is active in RefWorks is written next to MS Word Status.

Write-N-Cite provides only the essential items to allow more viewing area for your References:

**Search** - You can use the Search RefWorks feature and author hyperlinks to search through references.

**View** - From the View menu you can select to view All references or view by Folder; you cannot create or edit folders.

**Bibliography** – Where you go when you are ready to format your in-text citations and/or footnotes and generate your bibliography.

**Tools** – Provides various conversion and unformatting options:

- **Convert to WNC III Document**: Takes a document created with a previous version of Write-N-Cite and adds the Microsoft Word field codes to make it compatible with Write-N-Cite III (beta)

- **Display Unformatted Citations**: Changes formatted in-text citations and/or footnotes and reverts them to temporary citation placeholders. The bibliography and endnote formatting remains displayed in the document. This does not remove field codes.

- **Revert to WNC v.2 Document**: Takes a WNC III document and removes all field codes and replaces them with traditional temporary citation placeholders. Also removes bibliography and endnote formatting. This feature is useful if you want to share your unformatted document with a Mac WNC users or with a Windows WNC v.2 user.

- **Create/Update Offline Database**: Allows you to download a copy of your RefWorks account for offline use. Works only when you are online and logged into Write-N-Cite III for Windows.

- **Remove Field Codes**: This tool removes all coding from your document when you are ready to submit.

Before you start this process -- we **strongly** recommend you save a copy of your document with a different name, as this option removes all field codes from your document and documents without field codes cannot be updated or reformatted with RefWorks.

- **Language**: Allows you to change the language of the WNC III interface.
Help – Access to the RefWorks online help section on Using Write-N-Cite

Sort - You can also sort the reference list by selecting a sort option from the Sort by list.

View Link – allows you to see the full reference

Edit Citation Link – Launches the Citation Editor where you can modify in-text citations or footnotes by adding text, suppressing information, or changing citation order in multiple citations.

Note: You may have the full version of RefWorks open at the same time you have Write-N-Cite open. If you make edits in RefWorks be sure to refresh Write-N-Cite (which you can do by changing the view) to reflect the edits.

Using Write-N-Cite III for Windows Offline:

Write-N-Cite III has a feature that allows you to download your references to a computer and access those references to use while writing your paper. In addition to being able to view the references and insert temporary citation placeholders, Write-N-Cite III allows you to format a bibliography in the style of your choice while being offline.

Write-N-Cite III offline functions the same as if you were online. Regardless of whether you are online or not, you cannot add, edit or delete references in your account. You need to log in to your RefWorks database to perform those functions.

Downloading Your RefWorks Account To Work Offline:

1. Launch Write-N-Cite III and log in. You must be online in order to download your RefWorks database. Once the data is downloaded you can then use Write-N-Cite III offline.

2. From the Write-N-Cite III Tools menu, select Create/Update Offline Database.

3. Click the Create button.

4. Your data is downloaded.

   • Note: Each time you update your RefWorks account and you want to work offline, you will need to repeat steps 1 through 4 above to update the references stored on your local computer.

1. Click the Work Offline checkbox to work offline.

Logging in to Write-N-Cite III Offline:

1. Launch Write-N-Cite III.

2. Click the Work Offline checkbox to work offline.
Using Write-N-Cite III Offline:

1. Once you have downloaded your references following the instructions above, you can use Write-N-Cite III as you would if you were online. Launch Write-N-Cite for Windows from within Word by clicking the toolbar button or by selecting Write-N-Cite from the Tools menu. You can also launch the program from the Write-N-Cite icon on your desktop or by clicking the Start menu and selecting RefWorks from All Programs. If you launch the program from the desktop icon, it automatically opens a copy of Word.

   1. When the login dialog box appears, enter your user name and password and click Login.

   2. Click the box next to Always on Top to keep Write-N-Cite III on top of all other programs including Word. Also, notice that the name of the Word document that is active in RefWorks is written next to MS Word Status.

   3. Make sure the Work Offline checkbox is marked.

   4. Write-N-Cite III provides only the essential items to allow more viewing area for your references.

      ▪ **Search** - You can use the Search RefWorks feature and author hyperlinks to search through references.
      ▪ **View** - From the View menu you can select to view All references or view by Folder; you cannot create or edit folders.
      ▪ **Bibliography** – Where you go when you are ready to format your in-text citations and/or footnotes and generate your bibliography.
      ▪ **Tools** – Provides various conversion and unformatting options:

         - **Convert to WNC III Document**: Takes a document created with a previous version of Write-N-Cite and adds the Microsoft Word field codes to make it compatible with Write-N-Cite III (beta).

         - **Display Unformatted Citations**: Changes formatted in-text citations and/or footnotes and reverts them to temporary citation placeholders. The bibliography and endnote formatting remains displayed in the document. This does not remove field codes.

         - **Revert to WNC v.2 Document**: Takes a WNC III document and removes all field codes and replaces them with traditional temporary citation placeholders. Also removes bibliography and endnote formatting. This feature is useful if you want to share your unformatted document with a Mac WNC users or with a Windows WNC v.2 user.
If you want to format your bibliography directly from the RefWorks Bibliography area, you must revert your document to this format.

- **Create/Update Offline Database:** Allows you to download a copy of your RefWorks account for offline use. Works only when you are online and logged into Write-N-Cite III for Windows.

- **Remove Field Codes:** This tool removes all coding from your document when you are ready to submit.

Before you start this process -- we strongly recommend you save a copy of your document with a different name, as this option removes all field codes from your document and documents without field codes cannot be updated or reformatted with RefWorks.

- **Language:** Allows you to change the language of the Write-N-Cite III interface.

- **Help** – Access to the RefWorks online help section on Using Write-N-Cite III.
- **Sort** - You can also sort the reference list by selecting a sort option from the Sort by list.
- **View Link** – allows you to see the full reference
- **Edit Citation Link** – Launches the Citation Editor where you can modify in-text citations or footnotes by adding text, suppressing information, changing citation order in multiple citations.

**Note:** To delete temporary citation placeholders from your paper you **MUST** use the **Remove** option from within the Citation Editor. This is the only way to fully remove the coding stored in MS Word.

**Note:** You may have the full version of RefWorks open at the same time you have Write-N-Cite open. If you make edits in RefWorks be sure to refresh Write-N-Cite (which you can do by changing the view) to reflect the edits.

### Citing References

1. From your Word Processor, click the insertion point (the point where you want the reference inserted).

2. Switch to Write-N-Cite III and click the **Cite** link next to the correct reference. Write-N-Cite III automatically inserts the opening and closing curly brackets as well as the Ref ID, Author Last Name and Year. This is called a **Temporary Citation Placeholder** and it is what RefWorks reads when formatting your paper. It is not what your final citation will look like.

3. If you want to modify or remove information that will appear in the formatted citation, click on the **Edit Citation** link in the upper right-hand corner of the Write-N-Cite window.
4. To cite a second reference in the same location, click the Cite link for the second reference. The reference information is automatically inserted in the same set of curly brackets.

Editing Citations

The Edit Citation link launches the Citation editor which allows you to:

- preview your reference (and any modifications you make) in an output style of your choice
- modify how your citation will appear in-text or in a footnote by
  - suppressing (hiding) entire citation
  - suppress (hiding) the author
  - suppress (hiding) the year
  - adding text before the in-text citation
  - adding text after the in-text citation
  - adding a specific page number (overriding the page number in your RefWorks record). This feature only works if the output style you plan to use has page numbers in the in-text citation or footnote. Also, this is the ONLY editing feature that works with a footnote.

When you make any changes using the Citation Editor, your temporary citation placeholder (the temporary citation used by RefWorks to read and format your paper) will appear like this:

Before using the Citation Editor:

  {{14578 Babcock, L.E. 1988; }}

After using the Citation Editor to add a page number and text:

  {{14578 Babcock, L.E. 1988/p text before /f text after; }}

When you use the Citation Editor, you will see some coding inserted in your temporary citation placeholder. This coding (also called “switches”) tells RefWorks to do the action you specified. This coding is removed when your paper is formatted. See the online help file for detailed information on in-text switches.

Note: Make sure you “save to Word” any changes you make using the Citation Editor.

To edit an existing temporary citation placeholder, in Word, place your cursor within the double curly brackets of the temporary citation placeholder you wish to modify. The Edit Citation link will display in Write-N-Cite III and you can make any edits you desire.
**Important:** To remove a temporary citation placeholder from your paper, click on the **Remove** link to the left of the citation from the preview window in the Citation Editor and then the **Save to Word** button. You can also use the **Up** and **Down** links to change the order of your placeholders. Please note that the Output Style may override any order changes you make here.

**Creating a Bibliography Offline with Write-N-Cite III**

1. Click **Bibliography** to generate the formatted paper.

2. Select the correct **Output Style** and select **Create Bibliography**.

   You do not need to select the file since Write-N-Cite is already linked to the current document. The program formats your document with the in-text citations (or footnotes) and the bibliography.

3. If you want to revise your paper and add additional temporary citation placeholders you do NOT need to unformat your document. Simply add the new temporary citation placeholders to the appropriate spot(s) in the paper and reformat your paper. Your newly added placeholders will be formatted and the bibliography will be updated.

**Resolved Issues from Version 2:**

The crash that occurred while editing records when running WNC through your proxy server has been resolved.

The crash that occurred when using Words spell check feature on a document while WNC running has been resolved.

**Issues resolved from RC 1:**

A problem with multiple instances of WNC III running has been resolved.

A problem with the full version of RefWorks loading into WNC III has been resolved.

Manuscripts with large numbers of errors crashes WNC III has been resolved.

A erroneous "authentication errors: after running a bibliography has be resolved.

**Issues resolved from RC 2:**

A message is now displayed with WNC is not able to connect with the internet.

A problem with WNC hanging after selecting Load Word has been resolved.

When viewing Fields Codes in Word, the Edit Citation feature is now active.

A problem editing citations that caused large fonts to be displayed has been resolved.